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Section 1: Getting Started

Overview

LexisNexis® Automated Forms help you quickly generate accurate documents for 
your practice. After you install the forms set on your workstation, you can access it 
by starting HotDocs Player™ from the Start menu.

The CD you received includes the forms set and the latest version of HotDocs 
Player. Each of these must be installed separately. When you install them on your 
workstation, you should accept the standard settings defined by the installations, 
unless your system administrator tells you to make specific changes to these settings.

Note
If you want multiple users to access the forms set on a network drive, see “Install
LexisNexis Automated Forms on Multiple Workstations” on page 4.

Install HotDocs Player

If HotDocs Player is not already installed on your workstation, you will need  
to install it before installing the forms set.

Note
The latest version of HotDocs Player can be installed on the same computer as 
previous versions of HotDocs Standard or Professional Edition. (For best results, you 
should first download and install the latest service pack for your existing version of 
HotDocs at http://www.hotdocs.com/downloads/software-updates)

To install HotDocs Player

1. Insert the forms set CD into your CD-ROM drive. The LexisNexis 
Automated Forms CD browser window appears.

2. Click Install. The Install menu appears.

3. Click Install HotDocs Player. The installation program starts.

4. Follow the on-screen prompts to complete the installation. At the end of 
installation, click Finish.

Install LexisNexis Automated Forms

After HotDocs Player has been installed on your workstation, you are ready to 
install the LexisNexis Automated Forms set.

Tip: If the CD browser
window does not appear
automatically, select Run
(Start menu) and type
D:\autorun (where D:\ is
your CD-ROM drive).
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To install the forms set

Note
If you are installing the forms set immediately after installing HotDocs Player, the CD
browser’s Install menu should already be displayed. Skip to step 3.

1. Insert the forms set CD into your CD-ROM drive. The LexisNexis 
Automated Forms CD browser window appears.

2. Click Product Installations. The Install menu appears.

3. Click Install Automated Forms. The installation program starts.

4. Follow the on-screen prompts to complete the installation.

Note
Some virus scanners may display a warning message and block certain operations
during the installation. If this happens, choose the option that allows the operations 
to proceed. Otherwise, the forms set will not be installed correctly.

Install LexisNexis Automated Forms on Multiple 
Workstations

If you have obtained a multi-user license, you can install LexisNexis Automated 
Forms on your network and run HotDocs Player on multiple workstations. 
The multiple workstation setup differs from the standard setup by placing the 
template and library files on a network drive shared by all users instead of on local 
workstations. Also, the network administrator performs all updates instead of the 
individual users.

There are four parts to installing the LexisNexis Automated Forms on multiple 
workstations:

�� Set up the network drive that will store the forms set files.
�� Deploy the forms and workstation installation files to a folder on the network.
�� Customize the workstation install as desired.
�� Run the workstation installation program on each workstation. This program 
first installs HotDocs Player if it is not already installed on the workstation. 
Then it runs the Automated Forms workstation setup program, which creates 
shortcuts to the library on the network and configures HotDocs to access the 
Automated Forms from the network.

Note
If you are installing a new release of a forms set you have previously installed on the
network, you should use the same settings and file locations as the original installation. 
This ensures that users can continue accessing the forms as before without additional 
changes to individual workstations. However, if the new forms set includes an updated 
version of HotDocs Player, the new Player should be installed on each workstation.

Tip: If the CD browser
window does not appear
automatically, select Run
(Start menu) and type
D:\autorun (where D:\ is
your CD-ROM drive).
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Part 1: To set up the network for the forms set install

1. Identify a network drive accessible to all users who will use the forms set.

2. Ensure the target drive has sufficient space to store the forms set with its 
supporting workstation installation files. The space required varies depending 
on the forms set, but it is usually 100–250 MB. The network install will check 
for sufficient space before it copies files to the network.

3. Optionally, create a folder on the network drive where you want to store the 
forms set files. The network install will create a folder if one does not exist, 
but you may want to create a folder on the network drive to hold all of your 
LexisNexis Automated Forms sets.

4. Optionally, create a folder for answer files.

5. Set file system rights to the network folders. Generally, users accessing the 
forms on a network should have read-only access to prevent them from 
deleting or changing the files. The exceptions to this rule are the answer file 
and upload answer file folders that do require users to have write access. 
Network administrators should have full access to the network folders.

Part 2: To deploy the forms and workstation installation files to the 
network

Caution
Deploying the forms and workstation installation files to the network does not 
actually install software in the sense of adding it to Windows’ Add or Remove 
Programs list. Instead, it simply copies files to the network and configures them for 
easy distribution to individual workstations. If you wish to remove the files from the 
network, simply delete the contents of the network folder. Likewise, if the network 
location contains files from a previous install, you should delete the old contents 
before deploying the new files.

1. Insert the forms set CD into your CD-ROM drive.

2. Click the Start button on the Windows taskbar, and then select Run. 
The Run dialog box appears.

3. Type D:\ns\deploy.cmd (where D:\ is your CD-ROM drive), and then 
click OK. The installation program starts. Follow the on-screen prompts to 
complete the deployment.

4. When prompted for the Network location, specify the network location 
where the forms set and workstation setup program will be located. (This 
location must be different for each forms set you deploy to the network. 
You may use the same main folder, but each forms set must be deployed to a 
separate subfolder.)

5. At the Customizing the Workstation Installs dialog box, note the location of 
the workstation command (batch) file, workstation.cmd, and then click Install.

Part 3: To customize the workstation install

1. Browse to the location of the workstation command file (workstation.cmd) as 
noted in step 5 above.

Tip: If the network location
contains files from a
previous install, you should
delete the old contents
before continuing.
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2. Edit workstation.cmd (right-click and choose Edit from the shortcut menu). 
The file is opened in Notepad.

Note: The workstation command file allows network administrators to install 
HotDocs Player and Automated Forms on multiple workstations without 
manually changing the settings each time. It contains a number of msiexec 
commands, most of which should be commented out with the REM command.

3. Add or remove REM commands in the file so that commands with the desired 
arguments are activated. See “"Installation Command-Line Options" on page 
6” below, for a list of these options.

 Each command begins by calling Windows Installer (msiexec) with the install 
(/i) command-line option to indicate which installation package to install. For 
example:

msiexec /i "HotDocs Player Edition.msi" 
msiexec /i "LexisNexis Automated Forms.msi"

 Any parameters after the name of the installation package customize the 
behavior of the install.

4. Save your changes to workstation.cmd, and close Notepad.

Installation Command-Line Options

The following list describes the available command-line options and their associated
descriptions:

/qn
This option installs HotDocs or the template set silently. For example: 

msiexec /i "HotDocs Player Edition.msi" /qn

Caution
When this option is used, the install is completed without user intervention and
without any visible indication of the installation process. The user will not be
prompted for file locations or otherwise be able to customize or cancel the 
installation.

Windows Vista users: The silent install option, /qn, may not work properly 
on Windows Vista because of User Account Control (UAC). To display a reduced
dialog (progress bar and Cancel button only), use the /qb command-line
option.

INSTALLDIR

This option specifies a folder for HotDocs program files other than the default
location. You can use this property when installing HotDocs Player:

msiexec /i "HotDocs Player Edition.msi" INSTALLDIR="C:\HotDocs Player\"

This command would install HotDocs Player to C:\HotDocs Player\ rather than
the default (C:\Program Files\HotDocs 11\).
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FOLDER_ANSWERS
This option specifies a folder for HotDocs answer files other than the default
location. You can use this property when installing HotDocs Player:

msiexec /i "HotDocs Player Edition.msi" FOLDER_ANSWERS="K:\Answers\"

This command would set up HotDocs to use K:\Answers\ as the default answer
file folder.

Note
If HotDocs was installed previously, this will not replace a user’s existing answer 
file folder preference. In that case, HotDocs will continue to use the answer 
file folder previously specified by the user. See “Change HotDocs Program File 
Locations” in HotDocs Help for information about manually changing the answer 
file folder.

If this property is used once, it should also be used each time a subsequent 
version of HotDocs is installed.

WSINSTALL

When installing the template set on the administrator’s workstation, this option
must specify the folder in which the templates are located on the network:

msiexec /i "California Wills and Trusts.msi" WSINSTALL="H:\California Wills
and Trusts\"

INSTALL_HCAT

This option enables automatic update notifications. You can use it when 
installing the template set:

msiexec /i "LexisNexis Automated Forms.msi" INSTALL_HCAT=yes

In a network setup environment, one user is typically designated as the 
template set administrator. Automatic update notifications should be enabled 
for that user, but not for the rest of the users. In that way, only one user will 
see the update notifications and apply the updates, but all users will see the 
updated templates when the administrator applies the updates.

For information about automatic update notifications, see “Update the 
Templates in Your Template Set” on page 32.

/L*v

This option creates an installation log file. You can use it with the HotDocs
Player or template set install:

msiexec /i "HotDocs Player Edition.msi" /L*v C:\player.log
msiexec /i "LexisNexis Automated Forms.msi" /L*v C:\templateset.log

This option causes the install to create a log file with details about which files
were installed and whether the install succeeded or not. Log files are useful for
troubleshooting errors that may occur during the installation.
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Part 4: To run the workstation installation program on each workstation

1. At each workstation, click the Start button on the Windows taskbar, and then 
select Run. The Run dialog box appears.

2. In the Open box, specify the path to the workstation command file (for 
example, H:\workstation.cmd).

3. Click OK.

4. Follow the on-screen prompts to complete the installation. It will install 
HotDocs Player (if not already inst alled on the workstation), create shortcuts 
to the library on the network, and configure HotDocs to access the forms 
set on the network.

Use This Guide

This guide assumes you know how to use Windows. If you have questions about 
working with Windows (such as how to adjust or navigate windows), refer to your 
Windows help. To access Windows help, click the Start button on the taskbar, and 
then select Help and Support.

LexisNexis Automated Forms sets work in conjunction with Microsoft Word® and 
Corel® WordPerfect®. You should be familiar with the basic editing techniques in 
your word processor application.

Understand Your Professional Responsibility

You have licensed a forms set designed to assist you in your professional practice. 
It is your responsibility to review the templates and documents, determine their 
accuracy, and decide whether they meet your purposes. These materials are not 
intended as a substitute for your professional judgment.

Get Help While Using Your Forms Set

You can use the HotDocs help system to find information about HotDocs that can 
help you work with your forms set. To access the HotDocs Help, click the Help 
menu at the template library or assembly window, and then choose HotDocs Help. 
You can also press F1 from anywhere within HotDocs.

Tip: This batch file does not 
work if you run it from a 
UNC path. Map the network 
drive as needed to avoid 
this error.
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Use the Demonstrations on the Forms Set CD

The installation CD contains several demonstrations that give step-by-step 
instructions on how to use HotDocs and work with your forms set. These 
demonstrations introduce you to basic tasks of using the forms set.

To view a demonstration

1. Insert the forms set CD into your CD-ROM drive.
�� If autorun is enabled on your CD-ROM drive, the CD browser window 
appears.

�� If autorun is not enabled, click the Start button on the taskbar, and then 
select Run. At the Run dialog box, type D:\autorun.exe (where D:\ is your 
CD-ROM drive), and then click OK.

2. At the CD browser window, click Product Resources. The CD browser 
window changes to show a list of resources.

3. Click Demonstrations. The Demonstrations window appears.

4. Move the mouse pointer over the demonstration titles. A summary of each 
demonstration appears to the left.

5. Click the demonstration you want to view.
�� To navigate through a demonstration, click the right arrow to continue to 
the next step, or click the left arrow to return to the previous step. To end 
the demonstration, click the X in the upper-right corner.

6. When you are finished viewing the demonstrations, click the X button in the 
upper-right corner of the window. The Product Resources list appears again.

Update the Templates in Your Forms Set

Legal forms change frequently. Each time you start HotDocs, it automatically 
checks for updates to your forms set, provided you have an open Internet 
connection. If any updates are available, you will see a flashing  update icon in 
the status bar (lower right-hand corner of the HotDocs library window).

Caution
The first time you run HotDocs Player, your firewall software may warn you that
HotDocs is about to access the Internet. You should grant HotDocs permission to
access the Internet in order for the automatic template set update feature to work.

To update template sets automatically

1. Double-click the  update icon. The Install Template Set Updates dialog 
box appears, displaying a list of updates.

2. Select Install for each update item you would like to download and install.

Tip: You can also check for
updates manually at any
time by selecting Tools >
Update Template Sets.
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3. Select Discard for each update item you do not wish to install. HotDocs will 
not prompt you to install discarded updates again.

4. Click Continue. HotDocs installs the selected update items. If prompted, 
select Overwrite and Continue to replace old files with the updated files.

Note
If you are using a network install with multiple workstations, the automatic updates 
will only be available if the INSTALL_HCAT property was used in the workstation 
command file. (See, “Install LexisNexis Automated Forms on Multiple Workstations” 
on page 4.)

If you prefer not to use the automatic template set update feature, LexisNexis 
provides updates to Automated Forms through HotDocs auto-install (.HDI) files 
posted on the Internet. Follow these steps to update your forms and template 
library.

Note
Occasionally you may be asked to participate in a short, customer-satisfaction survey. 
These surveys usually contain about four questions and are distributed once a year. 
Completing the survey allows you to provide feedback to LexisNexis. If you choose not 
to participate in a survey, simply click the Close button on the survey message box.

To update template sets manually

1. In your Internet browser, go to http://support.lexisnexis.com/autoforms.

2. Browse to the update page for your forms set.

3. Click the desired update file. HotDocs installs the templates, and 
automatically opens the updated library.

Contact Technical Support

LexisNexis Technical Support specialists are available 24 hours a day, seven days 
a week. If you are having difficulty installing or using the software, or if you 
encounter an error message, please contact us:

 Technical Support Hotline: (800) 223-5297

To expedite your call, please be at the computer on which the program is running, 
and have your customer account number on hand.

If you encounter other problems, or if there are features you would like to see added 
to the software, contact us at:

 1-800-543-6862 
www.lexisnexis.com/autoforms

Or, you can submit your comments and requests using the form at this URL: 
https://support.lexisnexis.com/Custom/automated-forms-form/

Tip: Some template sets 
require a password to install 
updates. When prompted, 
enter the password found in 
your template library.

Tip: If the Discard check 
box is disabled for an 
update, it is a required 
update and it cannot be 
discarded. (You can choose 
to not install the update, 
but it will be displayed 
every time you check for 
updates.)
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Section 2: Use the HotDocs Template Library

Overview

Once HotDocs is installed, you can use the forms set templates to assemble 
documents. To access the templates, you will use the HotDocs template library.

The template library helps you organize various HotDocs files, including interview 
templates, text templates, and form templates. After you open the template library, 
you can use templates in the forms set to assemble documents.

Open the Library

The first step to using your template set is to open the template set library. 

To open the template library

1. Click the Start button on the Windows taskbar. The Start menu appears.

2. Point to Programs > LexisNexis Automated Forms.

3. Click the name of the forms set for the word processor you want to use. The 
template library opens, showing the templates in the forms set.

To close the template library

�� Select Exit (File menu), or click the X in the upper-right corner of the template 
library.

Tip: To learn more about 
the HotDocs library window 
and using template libraries, 
see the HotDocs Help. To 
access the HotDocs Help,  
select HotDocs Help from 
the Help menu, or press 
F1.
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Understand How the Template Library is Organized

The template library organizes the HotDocs files in your forms set. This makes 
it easier to locate and access the templates and clause libraries you need. Using a 
library lets you scan through titles and descriptions of templates, or you can search 
for specific files.

The template library window is divided into two panes. The left pane lists the items 
referenced in the library. The right pane displays information about a selected item, 
including a description, such as a note explaining when a template should be used. 
(For more information on working with a template library, see the HotDocs Help.)

To search for a specific item in the library

1. At the HotDocs library window, select the Find check box. The template list 
changes, showing the templates in alphabetical order.

2. In the Find box, type the text for which you are searching. The template list 
changes to show only the items with titles or descriptions that include that 
text.

 To view the entire library again, clear the Find check box.
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Identify the Different Types of Templates in a Library

LexisNexis Automated Forms sets contain several types of templates, each designed 
to help you assemble documents.
Interview Templates

 An interview template does not assemble a document. This kind of template 
gathers and saves information in a HotDocs answer source. Providing answers 

for an interview template is also called completing an intake interview. The answers 
from the intake interview can then be used in assembling other documents.

For example, a template library might include an interview template named Client 
Information. This template could gather general information about each client— 
such as a name, address, gender, date of birth, and so forth. You could assemble 
this interview template first and create a set of answers in the answer source. Then, 
when you assemble other documents that ask for client information, the answers 
are available for you to select.

Text Templates

A text template is created and automated in a word processor, such as Microsoft 
Word or Corel WordPerfect. After you assemble a document using a text 

template, you can view the document in your word processor and edit any section 
of the text.

Form Templates

A form template is a static form, or one in which the underlying text cannot be 
changed or modified. You can provide answers for these graphic-based 

documents by answering a series of dialogs, or by using direct-fill assembly to type 
answers directly on the form. In form templates, though, answers are limited to a 
specific area on the page, which may not provide enough space for the answer. 
Answers that overflow can be sent to an addendum.
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Section 3: Complete an Intake Interview

Overview

Frequently as you assemble documents, you are required to enter the same 
information multiple times. For example, you may need to enter information about 
the attorneys associated with a specific case. Rather than enter this information each 
time you need to create a document, you can instead complete an intake interview 
and save this information in an answer source.

Then when you assemble any documents where this information can be used, a 
Select button appears on the dialog. You can click the Select button to access the 
answers you provided at the intake interview.

Create an Answer Source

To create an answer source, you must assemble an interview template. This template 
simply asks the questions that may be used throughout the template set. Answers 
you enter are saved to an answer file, which you can then access from dialogs 
requiring the same information.

To provide information for an intake interview

1. At the HotDocs library window, select the interview template and click 
Assemble. The assembly window appears, showing the 

informationgathering dialogs.

2. Type answers for the questions and click  Add Another. HotDocs displays 
another empty dialog for you to enter answers.

3. Repeat this process until you have entered all the answers you need.

4. When you are finished, click  Finish. The answers you entered are 
automatically saved to an answer source. (For information on accessing 
answers in an answer source, see “Section 4: Assemble a Text or Form 
Document” on page 15.)

Tip: To learn more about
completing HotDocs in-
terviews, see the HotDocs 
Help. To access the HotDocs 
Help, select HotDocs Help 
from the Help menu, or 
press F1.
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Section 4: Assemble a Text or Form Document

Section 4: Assemble a Text or Form Document
In HotDocs, all types of documents can be assembled in the same way. The general 
process is explained in this section, while details specific to assembling form (or 
graphical) documents are presented in the next section, “Section 5: Directly Fill a 
Form Document” on page 26.

Overview

To assemble a document using the forms set, you select the appropriate template 
from the library window. This starts an interview where you can provide answers, 
and then save and print the completed document. You can also save the answers 
you provide in an answer file, which allows you to use those answers to quickly 
assemble other documents.

The following graphic shows the process of completing a document:

This section will address the following tasks:

��  Starting an interview to assemble a document.
��  Selecting an existing answer file.
��   Providing answers for the interview (including how to access answers from an 
answer source).

��  Accessing resource information to help you answer questions.
��   Using the End of Interview dialog to preview documents, send them to other 
applications, or save them.

��  Saving information in an answer file.
��  Viewing question or answer summaries.
��  Printing completed documents.

Select a Form
Template within
a HotDocs Library

Answer Questions at the
HotDocs Interview

Re-use the Answers
in an Answer File to

Complete Other Forms

Edit

Print

Save

Save

Completed
Form

Answer File

Tip: To learn more about 
assembling documents in 
HotDocs, see the HotDocs 
Help. To access the HotDocs 
Help, select HotDocs Help 
from the Help menu, or
press F1.
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�� Opening saved documents.

Start an Interview

When you open HotDocs, the template library window appears, listing the 
available templates. To verify that you have selected the correct template, you can 
use the Preview tab to see the general appearance of the document. (For more 
information on searching for templates or previewing documents, see the HotDocs 
Help.)

When you select a template and begin assembling a document, you start the 
interview process.

To start an interview

1. At the HotDocs library window, locate and select a template. The Properties 
tab of the library window changes to show information about that template.

2. Click  Assemble. The HotDocs assembly window appears and the Answer 
File dialog box appears.

Select an Answer File

You can use answer files you have previously created to assemble new documents. 
When you start an interview, the Answer File dialog box appears, which allows you 
to either select an existing answer file or create a new one.

To select an answer file

1. At the Answer File dialog box, accept the suggested answer file by clicking 
OK, or change the answer file by clicking one of the answer file buttons:

��  Select Answer File opens the Select Answer File dialog box where you 
can choose an existing answer file. After making your selection, click 

 Select.

��  New Answer File creates an empty, untitled answer file.

2. Optionally, select Automatically select this answer file for use with the next 
assembly.

 This will cause the same answer file to be suggested for every interview so that 
you don’t have to manually select it each time you assemble a document. The 
next time you start an interview, the same answer file will be suggested. You 
can, of course, choose a different answer file.

3. Click OK. The assembly window appears, showing answers from the selected 
answer file in the corresponding answer fields.

Tip: You can also start the
interview by double-clicking
the template.
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Section 4: Assemble a Text or Form Document

Provide Answers for an Interview

When you assemble a document, the interview appears in the HotDocs assembly 
window. Most templates include questions that have been arranged into related 
groups, called dialogs. The left pane of the assembly window, the interview outline, 
lists the dialogs used in each template. The right pane, or dialog pane, displays the 
specific questions used in each dialog.

Providing answers for these questions is the central task of an interview. You can 
enter all the necessary answers, or you can use information from an answer source. 
As you provide answers for each dialog, the icons in the interview outline change to 
reflect how much of the dialog is complete:

  None of the questions in the dialog are answered 
  At least one of the questions in the dialog is answered 
  All the questions in the dialog are answered 
  Repeats the dialog, allowing you to enter more than one set of answers 
   New, empty repeating dialog where you can add another set of answers to a 

list

Even if you use an existing answer file to provide information for the interview, you 
may still need to update some answers. You can modify existing answers or enter 
new information.

To enter answers in an interview

1. At the assembly window, select a dialog from the interview outline. The dialog 
pane changes to show the questions in that dialog.

2. Click in an answer field. That answer field becomes active.

3. Enter your answer.

4. Move to another answer field by:
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�� Pressing Tab to move to the next answer field.

�� Pressing Shift+Tab to move to the previous answer field.

�� Clicking another answer field in the dialog.

5. Move to another dialog by:
�� Pressing Page Up (takes you to the previous dialog) or Page Down (takes 
you to the next dialog).

�� Clicking a button in the navigation bar, located at the bottom of the dialog 
pane.

�� Selecting another dialog in the interview outline.

Enter a List of Answers

Some dialogs gather a list of information, instead of a single answer. These dialogs 
repeatedly display the same questions. To enter multiple records in a list, click the 

 Add Another button. When you are finished with the list, click  Next. You 
can also use your mouse pointer to select another dialog.

Use Answers from an Answer Source

If you have already provided answers in an intake interview, you can use that 
information to quickly provide answers for the document. Dialogs that can access 
an answer source where intake information is saved will display a  Select button.

To use answers from an answer source

1. In a dialog that includes a Select button, click the  Select button. A pop-
up dialog containing a spreadsheet of answers included in the answer source 
appears.

2. Optionally, modify answers in the answer source as follows:
�� Add new answers by selecting a blank row in the spreadsheet and clicking 

 Edit Row.

�� Edit existing answers by selecting the row you want to edit and clicking 
 Edit Row.

�� To remove answers from the answer source, select a row and click  Delete 
Row.

3. Select the desired set of answers from the list, and then click the  Select 
button. The assembly window appears again with the selected answers shown 
in the answer fields.

Tip: You can also modify 
an answer source by 
assembling the intake 
interview template again. 
See, “Section 3: Complete 
an Intake Interview” on 
page 14.
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Access Resources for Questions in an Interview

Some questions may include information to help you answer the question. If such 
information is included, the resource pane (below the dialog pane) displays the 
information.

If the resource pane is not visible, you can click the  Resource button, or select 
Dialog Resource Pane (View menu). You can change the size of the resource pane 
by selecting the top border of the pane and dragging it up or down.

Preview a Completed Document

After entering answers in the interview, you can print or save the completed 
document, or attach it to an e-mail message. Before doing any of these tasks, you 
can view the assembled document in the assembly window and make sure the 
information is accurate.

You can preview both a text document and a form document.

To preview a text document

1. At any time during assembly, click the Document Preview tab. The assembly 
window changes to show a preliminary version of the document.

2. Scroll through the document to verify that the information you have provided 
is correct.

 Answers are shown merged into the document text. To change an answer, you 
must click the Interview tab again, and navigate to the appropriate dialog.

Tip: The Document 
Preview tab may not 
accurately display formatting 
details, such as text 
alignment or font formatting. 
These variations occur only 
in the preview; the final 
document will be formatted 
as you expect it.
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Note
When assembling a Word template, you may also double-click the answer at the 
Document Preview tab to view its dialog and modify the answer without switching 
to the Interview tab.

To preview a form document

1. At any time during assembly, click the Form Document tab. The assembly 
window changes to show the form document.

2. Scroll through the document to verify that the information you have provided 
is correct.

 Answers are shown in answer fields. To change an answer, select the field and 
type the new information.

Note
Typing or changing answers at the Form Document tab (instead of the Interview 
tab) is referred to as direct-fill assembly. Some form templates require direct-fill 
assembly for some or all of the answers. See “Use Direct-Fill Assembly for a Form 
Template” on page 26.

Use the End of Interview Dialog

The End of Interview dialog appears after the last dialog in each interview. At the 
top of the dialog, unanswered questions are reported. Below that are buttons for 
working with your document, and check boxes for closing the assembly window.

By selecting the close this window check box with various options, HotDocs will 
automatically close the assembly window. HotDocs remembers which check boxes 
are selected and will use these settings in future assemblies.
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When the assembly window closes, HotDocs may ask if you want to save the 
assembled document. If you already sent the document to the word processor 
or HotDocs Filler, or saved it in a file, there is no need to save the assembled 
document again. You can select Don’t ask me about saving again and click Don’t 
Save to prevent HotDocs from asking each time you close the assembly window.

This section describes the buttons that appear by default at the End of Interview 
dialog. The buttons available will vary according to the type of document you 
are assembling. Also, depending on your work preferences, you can select which 
buttons will appear at the End of Interview dialog. (See, "Customize the End of 
Interview Dialog" on page 22.)

Review Unanswered Questions

If you skip questions during the interview, HotDocs will display a message at the 
End of Interview dialog indicating how many questions are unanswered. Normally, 
you should answer each of these questions before proceeding.

To return to unanswered questions in the interview

1. At the End of Interview dialog, click  Go to the first unanswered question 
in the interview to return to the place in the interview where the first 
unanswered question appears.

2. Click the  Next Unanswered Dialog button in the navigation bar to navigate 
to each subsequent unanswered question in the interview.

3. When all questions are answered (as indicated by  icons in the interview 
outline), click the Next Unanswered Dialog button to display the End of 
Interview dialog.

View an Assembled Form Document

After you complete an interview, you can view the assembled form document at the 
Form Document tab.

To view an assembled form document

1. At the End of Interview dialog, click  View the assembled form document 
at the Form Document tab. The assembly window changes to display the 
form document.

2. Optionally, if you want HotDocs to notify you of any overflowing answer 
fields when it displays the form document, select check for answer overflow.

Tip: You can also prevent 
HotDocs from prompting 
to save documents when 
closing the assembly window 
by making a selection at the 
HotDocs Options dialog 
box. In the Document 
Assembly folder, clear 
Prompt to save document 
when closing assembly 
window.
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Send a Text Document to the Word Processor

After you complete an interview, you can view the assembled text document in 
your word processor.

To send a text document to the word processor

�� At the End of Interview dialog, click  Send the assembled document to 
the word processor. The word processor appears, showing the completed 
document.

Note
If there are any unanswered questions, a dialog box may appear giving you the option 
of returning and answering these questions. You can ignore this option and still send 
the document to the word processor, but be aware that some of the answers may 
be missing and information in the document that relied on this information may be 
incorrect.

While you are assembling a document, you can change an answer in one location 
and that change is applied throughout the document. However, once you save a 
document, it is separated from HotDocs and no longer functions as an automated 
form. This means you must manually locate and change each answer that needs 
to be modified. If you must change answers in an assembled document, it is 
recommended that you reassemble the document using the original answer file and 
make your changes during assembly.

Paste an Assembled Text Document into an Existing 
Document

You can paste (insert) an assembled text document into an existing word processor 
document. For example, if you have an existing contract, you can assemble a 
document containing additional terms to the contract and paste those new terms 
into the existing document.

To paste an assembled text document into an existing document

1. In your word processor, open the document into which you want to paste the 
assembled document.

2. Place your cursor at the location in the document where you want to paste the 
assembled document.

3. At the End of Interview dialog, click  Paste the assembled document into 
the open word processor document. The word processor appears, showing 
the assembled document inserted into the existing document.

Customize the End of Interview Dialog

The buttons available at the End of Interview dialog will vary according to the type 
of document being assembled. Additionally, you can choose which buttons will

Tip: This dialog box 
only appears if Display 
unanswered warning 
before saving documents 
is selected in the 
Document Assembly 
folder of HotDocs Options.

Tip: Pressing F11 will also
send the document to the
word processor.
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appear at the End of Interview dialog and what happens when you click the 
 Finish button in the navigation bar. For information about which buttons are 

available, refer to the HotDocs Help.

To choose which options appear at the End of Interview dialog

1. At the End of Interview dialog, click  Choose which buttons are displayed 
on this dialog. The HotDocs Options dialog box appears showing the End 
of Interview folder.

2. In the End of Interview Buttons group, choose which buttons you want on 
the End of Interview dialog by selecting the corresponding check box.

To define how HotDocs should finish an interview

1. At the End of Interview dialog, click  Choose which buttons are 
displayed on this dialog. The HotDocs Options dialog box appears showing 
the End of Interview folder.

2. In the Finish Interview Action group, select an option for text and form 
documents as explained in the following table:

To Do This

Send all assembled
text documents
directly to the word
processor

Select Send assembled text documents to 
the word processor and close.

Preview all assembled
text documents
at the Document
Preview tab of the
assembly window

Select Proceed to the Document Preview 
tab.

Send all assembled
form documents
directly to HotDocs
Filler

Select Send assembled form documents to 
HotDocs Filler and close.

Display all assembled
form documents
at the Form
Document tab

Select Proceed to the Form Document tab.

Now, whenever you click the  Finish button in the navigation bar, HotDocs will 
perform the action you specified.

Save an Answer File

By saving your answers in an answer file, you can reproduce exact copies of a 
document, or assemble other documents that ask the same questions. You can 
access saved answer files using Answer File Manager. (For more information about 
answer files, see the HotDocs Help.)

Tip: You can also click
Options at the Tools
menu.

Tip: Buttons will be included
only if they are selected and
if they are relevant to the
current interview. For
example, HotDocs will
display the  Go to the
first unanswered
question in the interview
button only if there is at
least one unanswered
question in the interview.
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To save an answer file

1. At the assembly window, click the  Save Answers button. The Save Answer 
File dialog box appears.

2. At the Type drop-down list, select an answer type.
�� XML answer (.ANX) files allow the answers to be used in other HotDocs 
interviews. The XML format also allows them to be used to deliver 
information to a database, third-party application, or Internet site.

�� Standard answer (.ANS) files allow the answers to be used in other 
HotDocs interviews.

3. Provide a file name, title, and optional description for the answer file. This 
information will appear in Answer File Manager.

4. Click OK. The answer file is saved.

View a Summary of Questions or Answers

You can generate a brief summary of the questions and/or answers that are used in 
a completed document. You do this by viewing the Question Summary or Answer 
Summary for a given document.

A Question Summary shows an outline of dialogs and questions. You can print 
Question Summaries to use as questionnaires. An Answer Summary presents both 
the questions and the answers used to assemble a document. This provides a context 
for the answers without requiring you to read the entire document, and it can be an 
effective format to keep printed copies of your work.

To view a Question or Answer Summary

�� At the assembly window, click the Question Summary or Answer 
Summary tab. The assembly window changes to show the selected 
summary.

Print a Completed Document

Many projects require you to print copies of your completed documents.

To print a document

1. At the assembly window, click the Document Preview tab (for form 
templates, the Form Document tab). The assembly window shows a preview 
of the document.

2. Click the  Print Document button on the toolbar. The document is sent to 
the specified printer.

Tip: If you are working with
an existing answer file, any
changes you have made are
saved.

Tip: Use clear, consistent 
naming conventions, so 
you can more easily locate 
answer files for later use.

Tip: To hide or show the
summary tabs, select (or
clear) Question Summary
Tab or Answer Summary
Tab in the View menu.
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Open a Saved Document

After completing a document and saving it, you can later edit the document in the 
appropriate application:

�� Text documents are saved as word processor files (.DOC, .WPD, or .RTF). To 
edit these files, you must use a word processor.
�� Form documents are saved as HotDocs form files (.HPD or .HFD). To edit 
these files, you must use HotDocs Filler.

Note
Once a document is saved, it no longer functions as an automated template. If you 
want to change an answer, you must manually locate each place that answer appears 
in the document. Also, if the answers you change were part of a calculation, you 
must manually recalculate the results. If you must change answers in an assembled 
document, it is recommended that you reassemble the document using the original 
answer file and make your changes during assembly.

To open a saved text document (.DOC, .WPD, or .RTF format)

1. Open your word processor.

2. Select Open (File menu).

3. Browse to the saved document and click Open.

To open a saved form document (.HPD or .HFD format)

1. Open HotDocs Filler by selecting Start > Programs > LexisNexis HotDocs 
Player > HotDocs Filler.

2. Select Open (File menu)

3. Browse to the saved document and click Open.
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Overview

In most cases, completing form documents is exactly like completing text 
documents—a series of questions appear and you enter your answers. However, 
because the underlying text in a form template is static (meaning, it doesn’t 
change), there are some tasks that are unique to completing form documents, 
such as handling answers that don’t fit in the allotted space, as well as the ability to 
enter answers directly on the face of the form (rather than using the pre-designed 
interview). (For more information on working with form templates, see the 
HotDocs Help.)

Use Direct-Fill Assembly for a Form Template

At times, you may choose to complete a document by entering your answers while 
viewing the document at the Form Document tab. In fact, some LexisNexis 
Automated Forms require you to fill the form using this method. 

Tip: To learn more about 
using HotDocs form 
templates, see the HotDocs 
Help. To access the HotDocs 
Help, select HotDocs Help 
from the Help menu, or 
press F1.
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Note
While entering answers directly at the Form Document tab may seem quicker and 
easier, often important information about the answers you are entering only appears 
when you are viewing the Interview tab. Because of this, it is recommended that, 
where possible, you use the Interview tab.

To enter answers directly on the form

1. At the HotDocs library window, select a form template and begin assembling 
the document. (See “Section 4: Assemble a Text or Form Document” on page 
15.)

2. If it’s not selected automatically, click the Form Document tab. The assembly 
window changes to show the form document and the answer fields.

3. Select a field. The field changes color.

4. Enter an answer, either by typing your answer or by selecting an existing 
option.

5. Press Tab to move to the next field, or use the mouse to select another field.

Note
When you select certain fields, they may turn gray, not allowing you to type in the 
field. Instead, you can click the  Answer Wizard button that appears to the right 
of the field. This will display a pop-up window where you can answer the variables 
needed to calculate the answer for that field.

Tip: You can also create a
new field at the Form
Document tab by clicking
the  Select Tool button,
and then drawing the field
on the document. To enter
text in the new field, click
the  Fill Tool button. The
field and text will be saved
in the current document,
but the answer will not be
saved in your answer file
and the field will not appear
in other documents 
assembled from the same 
template.
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Resolve Answer Field Overflow

When you type an answer in a field, HotDocs compares the size of the field and the 
length of the answer. If an answer uses more space than is available in that field, you 
are prompted to resolve the overflow.

During direct-fill assembly at the Form Document tab, HotDocs automatically 
checks each field when you move to another field. HotDocs also checks for any 
unresolved answer overflows when you save or print a document. In addition, you 
can manually check for answer overflow at any time. (For more information about 
answer field overflow, see the HotDocs Help.)

To check for and resolve answer field overflow

1. With the Form Document tab displayed, choose Check for Overflow (Tools 
menu). HotDocs begins checking answer lengths.

2. If an answer is too long, the Overflow Status dialog box appears. Make 
adjustments as explained in the following table:

To Do This

Edit the answer to
make it fit the field

Click Edit, and then change the answer.

Resize the field to
make it fit the
answer

Click Resize, and then change the size of the 
field.

Override the field
type and edit the
answer

Click Override, and then change the answer.

(Answers typed in overridden fields are 
not saved in the answer file. Instead, the 
original answer is saved in the answer file. 
The original answer will also be used if it’s 
required for answering other questions, such as 
calculations.)

Shrink the font size
until the answer fits
or the minimum font
size is reached

Select Shrink the answer to fit in the field.
If the answer is still too large for the field,
you must select another option to resolve
the overflow.

Send the entire
answer to the
addendum

Select Send the answer to the addendum.
(See the next section, “Work with an 
Addendum.”)

Resolve the overflow
later

Click Ignore.

Work with an Addendum

The default addendum appearance may not be consistent with your project 
standards.
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You can change the addendum items and references, as well as the fonts, spacing, 
headers, footers, page numbering, and page formatting. You can also choose to 
format the addendum as a pleading paper. (For additional information about 
changing addendum properties, see the HotDocs Help.)

To change the addendum format

1. At the HotDocs library window, select a form template and begin assembling 
the document. (See “Section 4: Assemble a Text or Form Document” on page 
15.)

2. At the assembly window, click the Form Document tab.

3. Click Document Properties > Addendum (File menu). The Addendum 
Properties dialog box appears.

4. Make changes as described in the following table:

To Do This

Include header or
footer text in the
addendum

Type the desired text in the Header text or
Footer text field.

Control the alignment
of the header
or footer text

Select an option from the Alignment dropdown
list in the Header properties or Footer
properties group.

Control the height of
the header or footer

Change the Height setting in the Header
properties or Footer properties group.

Specify the
addendum page
margins

Specify the margin settings in the Page
margins group.

Control the distance
between labels and
answers

Change the setting in the Indentation field.

Specify the
addendum as a
pleading paper

Select Number lines to format as pleading
paper. HotDocs places line numbers in the
left margin of the addendum.

To change the reference and label text for a specific field’s addendum 
item

1. At the Form Document tab, select the field and click Properties (Field 
menu). The Properties dialog box appears.

2. At the Overflow tab, type text in the Cross-reference text box to specify the 
text that appears in the form field when the answer is sent to the addendum.

3. Type text in the Addendum label text box to specify the text that appears next 
to the answer in the addendum.
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Overview

When you save an answer file, HotDocs adds the file to Answer File Manager. 
Using Answer File Manager, you can manage and use your answer files more easily.

Answer File Manager automatically tracks all the answer files you create. You 
can also add answer files you receive from other sources. You can modify the 
properties of these answer files by modifying their file names, titles, locations, and 
descriptions.

Answer File Manager tracks the history of when each answer file has been used. 
Also, at the Contents tab, you can view the answers currently saved in each file. 

The Sort and Find features in Answer File Manager can help you locate answer 
files. To rearrange the order in which the answer files appear, click the  Sort 
button, and then select a sorting option. To search for a specific answer file, select 
the Find check box, and then type the text for which you are searching. HotDocs 
filters the list of answer files to show only those that contain that text in their titles 
or descriptions.

Add Existing Answer Files to Answer File Manager

When you create an answer file, HotDocs automatically adds it to Answer File 
Manager. If you receive answer files from other sources, you must manually add 
those answer files to Answer File Manager. While using Answer File Manager, you 
can organize your answer files into folders as well as modify the properties of the 
answer files.

When you receive answer files that others have created, you must manually add 
them to your Answer File Manager.

Tip: To learn more about
managing answer files, see
the HotDocs Help. To access
the HotDocs Help, select
HotDocs Help from the
Help menu, or press F1.
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To add an existing answer file to Answer File Manager

1. At the HotDocs library window, click the  Answer File Manager button. 
The Answer File Manager window appears.

2. Click  Add. The Add Item dialog box appears.

3. Click the  Browse button next to the File name box, and then locate and 
open the file.

4. Type a name for the answer file in the Title box or click the  Get Title 
button to use the default title (if any). This title will identify the answer file in 
Answer File Manager.

5. Optionally, type a description in the Description box to help you identify 
the answer file. This description appears at the Properties tab of Answer File 
Manager and can be used when searching for specific answer files.

Note
You can also double-click an answer file in Windows Explorer to automatically copy it 
to your answer file folder and add it to Answer File Manager.

Create a Folder

You can organize your answer files by creating folders and subfolders.

To create a folder in Answer File Manager

1. At the Answer File Manager window, click the  Add button. The Add Item 
dialog box appears.

2. Select Folder from the Type drop-down list. The dialog box changes to show 
the options needed for new folders.

3. Type a name for the folder in the Title field.

4. Optionally, type a description about the folder in the Description box. (This 
description will appear at the Properties tab of Answer File Manager.)

5. Click OK. The folder is added to the answer library.

Manage Your Answer Files

When you are viewing Answer File Manager, you are not viewing the actual answer 
files—instead, you are viewing references to the actual answer files, similar to 
Windows shortcuts on your computer desktop.

Because of this, use caution when moving answer files on your workstation, or 
changing file paths in Answer File Manager. If the file path does not match the 
actual file location, you will be unable to access that answer file.

Tip: You can add multiple
answer files at one time.
When browsing for files, you
can press Ctrl or Shift to
select multiple files. Or,
typing a folder path, you
can select all files in the
folder by using the following
format in the file name box:
C:\folder path\*.ANS.
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To manage your answer files

1. Click the  Answer File Manager button. The Answer File Manager dialog 
box appears.

2. Complete any of the tasks described in the following table:

To Do This

Create a new, empty
answer file

Click the  New button.

Delete an answer file Select the answer file, and then click the
 Remove button.

Sort answers in
alphanumeric order,
based on titles

Select a folder, and then click the  Sort
button.

Search for a specific
answer file

Select Find. In the text box type some text
from the answer file’s title or description.

View the answers
currently saved in
the answer file

Select the answer file, and then click the
Contents tab.

Find when an answer
file was used to
assemble documents

Select the answer file, and then click the
Properties tab.

Change the title,
path, file name,
history, or description

Select the answer file, click the  Properties
button, and make the changes.

Change a folder’s
title or description

Select the folder, and then click the 
 Properties button and make the changes.

Delete a folder Select the folder, and then click the
 Remove button.

Move an answer file
to a different folder

Double-click the folder to open it, and then
select the answer file and drag it to the
folder.
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Glossary

Glossary
Addendum – pages added to a form document to show answers that don’t fit in 
the form fields.

Answer file – a file that contains the information used to assemble a document.

Answer File Manager – the tool used to organize and access answer files.

Answer source – a file that contains answers provided during an intake interview; 
you can use these answers when assembling other documents.

Answer Summary – an outline showing the dialogs, questions, and answers used 
to assemble a document.

.ANS – the file name extension for a standard HotDocs answer file. See also .ANX.

Answer wizard – a special button that appears next to an answer field in a form 
document. Clicking this button displays dialogs to help you answer the question.

.ANX – the file name extension for a HotDocs XML answer file, which uses an 
open file format useful for delivering information to a database, a third-party 
application, or an Internet site. See also .ANS.

Assembly – the process of completing an interview; providing information for a 
HotDocs template in order to generate a document.

Automated form – a HotDocs template containing variables.

Clause – a section of standard text that can be used in various documents.

Clause library – a collection of clauses where users can select specific paragraphs 
or sections of text to be added to a document.

Dialog – a group of related questions in an interview.

Direct-fill assembly – the process of typing information directly in answer fields 
on a form template. See also Interview.

Document – paperwork used in your practice; prepared by providing answers for 
a HotDocs template during an interview.

Field – a block on a form template prepared to hold answers.

Field overflow – a situation in a form document where the provided answer is 
larger than the space available in the field.

File name extension – the final letters of a file name that specify the file type, 
.DOC, for example.

Fill – provide answers for a HotDocs form document.

Forms set – a collection of HotDocs templates, distributed by LexisNexis.

Form document – a document that contains all the answers required to be 
completed. A form document’s underlying text is static, meaning it cannot be 
altered or changed. See also Text document.
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Form template – a file that contains special fields (or variables) where answers will 
be merged to produce a completed document. A form template’s underlying text is 
static, meaning it cannot be altered or changed. See also Text template.

.HFD, .HPD – the file name extensions of completed HotDocs form documents.

History – a record of when and with which templates an answer file has been 
used.

HotDocs® Filler – an application that lets you edit saved form documents.

HotDocs® PDF Advantage – an application that allows you to save assembled text 
and form documents as PDF files.

HotDocs® Player – an application that lets you assemble published HotDocs 
templates.

Intake Interview – the process of providing answers for an interview template, 
gathering information into an answer source for quick access later.

Interview – a series of grouped questions you must answer in order to produce a 
completed document.

Interview template – a special kind of HotDocs template that gathers answers for 
use with other documents. It produces an answer file instead of a document.

Library – a collection of HotDocs templates, clauses, or answer files.

Navigation – moving from dialog to dialog during a HotDocs interview.

Pleading paper – a format that can be applied to a form document’s addendum, 
where line numbers are printed in the left margin.

Question Summary – an outline showing the dialogs and questions in a template 
that need to be answered to complete a document.

Repeated dialog – a HotDocs dialog that repeatedly asks the same questions, 
gathering a list of information.

Template – a HotDocs file where instances of variable text have been replaced 
with HotDocs variables.

Text document – a document that contains all the answers required to be 
completed. A text document is viewed using a word processor. See also Form 
document.

Text template – a file that contains special fields (or variables) where answers 
will be merged to produce a completed document. A text template is created and 
edited using a word processor. See also Form template.

Title – the name associated with a given file to help you identify it in its 
corresponding library.

Variable – a special field in a HotDocs template where information that 
changes—depending on the user—is merged.


